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	Chapter 6
	Pre Test / Post Test Questions


Fill in the blanks:

1. A _____ query displays a dialog box and accepts input from the user before proceeding.

2. Using a graphical _____-by-_____ approach, the query Design window lets you select field columns for display, enter criteria statements, specify sort orders, and perform calculations.

3. The query _____ _____ contains the fields for display, filter criteria, and sort order selections.

4. Queries, sometimes called _____, provide an important role in retrieving and displaying data stored in a relational database system.

5. The fastest way to add a field to the next available query column is to _____ on the field.

6. To delete a field from a query, select the field column in the design grid and choose the _____ _____ menu item from the Edit menu.

7. You can create _____-_____ sorts by selecting more than one field in the design grid (for a query).

8. The first field that a dynaset is sorted by is known as a _____ sort key.

9. A _____-by-_____ calculation computes a result for each record returned in a dynaset.

10. To set a query field’s properties, you should ______-______ on the field’s column in the Design grid to access the Field Properties dialog box.

Multiple choice:

11. Which type of query performs mass changes to the data it retrieves?

a. action query

b. parameter query

c. crosstab query

d. simple query

12. Which type of query summarizes numerical results in a spreadsheet-like table?

a. action query

b. parameter query

c. crosstab query

d. simple query

13. Which query criteria operator is used to represent a single character?

a. “*”

b. “>”

c. “<”

d. “?”

14. If table relationships have yet to be defined, Access can automatically create relationships for you in a query as long as which of the following are true?

a. both tables contain a field of the same name and same data type

b. one of the fields is a primary key

c. both a and b

d. neither a nor b

15. Which dialog box in Design View allows you to add new tables to a query?

a. Add Table
b. Show Table
c. Query Table
d. Show Query Table
16. When sorting data in a query, you can sort by which of the following?

a. Ascending

b. Descending

c. not sorted

d. all of the above

e. none of the above

17. You use filters to do which of the following?

a. limit the display of records

b. add more records to a query

c. relate data between two tables

d. none of the above

18. Which type of logic is the method by which criteria statements are joined and executed in a query?

a. Standard

b. Conditional

c. Mathematical

d. Meta-Logic

19. Which of the following may a field expression contain?

a. table and field names

b. mathematical operators

c. comparison operators

d. logical operators

e. constants

f. all of the above 
g. only a, b and c
h. none of the above

20. Which Access tool helps you enter expressions for use in defining calculated fields and in specifying criteria for queries?

a. Expression Dialog Box

b. Expression Tool

c. Expression Builder

d. Expression Wizard

True / False:

21.  SQL stands for Standard Query Language.

22.  In a query, the source data tables are displayed in the Table pane of the query’s Design View.

23.  Date values are surrounded by number symbols (#) in conditional statements.

24.  Access enables you to join tables in your database for the purpose of sharing information and reducing data redundancy.

25.  After creating a multi-table select query, you can only specify criteria for one field that appears in the query.

26.  Table rows in the query design grid can be toggled on and off.

27.  Using a query for printing is especially useful for combining data that is stored in multiple tables.

28.  The third sort key in a query sort is also known as a secondary sort key.

29.  Generally speaking, if a value can be calculated for display, you should store it in the database.

30.  You can concatenate or join values in an expression by using the ampersand (&) symbol.

	Chapter 6
	Pre Test / Post Test Answer Key


Fill in the blanks

1. parameter (6.1:AC 6-3)

2. query-by-example (6.1.1:AC 6-4)

3. Design grid (6.1.1:AC 6-4)

4. views (6.2:AC 6-15)

5. double-click (6.2.2:AC 6-17)

6. Delete Columns (6.2.2:AC 6-18)

7. multi-key (6.3.1:AC 6-23)

8. primary (6.3.1:AC 6-24)

9. row-by-row (6.4:AC 6-37)

10. right-click (6.4.2:AC 6-41)

Multiple choice:


11. A (6.1:AC 6-3)

12. C (6.1:AC 6-3)

13. D (6.1.3:AC 6-10)

14. C (6.2:AC 6-15)

15. B (6.2.1:AC 6-15)

16. D (6.3.1:AC 6-23)

17. A (6.3.2:AC 6-27)

18. B (6.3.3:AC 6-30)

19. F (6.4.1:AC 6-37)
20. C (6.4.3:AC 6-43)

True / False:

21. F (6.1.1:AC 6-4)

22. T (6.1.1:AC 6-4)

23. T (6.1.3:AC 6-14)

24. T (6.2:AC 6-15)

25. F (6.2.3:AC 6-20)

26. T (6.2.3:AC 6-20)

27. T (6.2.4:AC 6-22)

28. F (6.3.1:AC 6-24)

29. F (6.4.1:AC 6-37)

30. T (6.4.3:AC 6-44)
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	Creating Select Queries


Overview

Chapter 6 provides a solid introduction to the mechanics of creating and modifying select queries in Microsoft Access.  The chapter covers such topics as creating new select queries, modifying existing queries, adding criteria to queries, print previewing, and printing query results.  Other key points include use and creation of multi-table queries, sorting query results (dynasets), applying query filters, using multiple criteria in queries, and creating calculated fields.  Use of the Expression Builder is also covered near the end of the chapter.

Tips and Teaching Strategies

The Access Expression Builder is a powerful tool with what some might consider a complex interface.  Consider demonstrating its use with very simple functions or references to database objects (table fields) and then adding to its use.  It is possible to build an expression with improper syntax using the Expression Builder.  Therefore, it is suggested that if you are planning to demonstrate its use, be sure to dry run your expression before showing it to the class.  Additionally, demonstrating how easy it is to build an improper expression could be useful as well.

Section 6.1 – Using the Query Design View
This section covers the basics of getting started with custom queries.  The subsections include instruction on the creation of a new query (from scratch), modifying an existing query, and adding simple search criteria to a query.

Section 6.1.1 – Creating a Query in Design View

Concept:
Creating a new query using Design View

Method:
To create a new query using the query Design View, select the Queries button in the Database Objects bar, and double-click the Create query in Design View icon (or click the New button in the Database toolbar window and double-click the Design View item in the New Query dialog box).

Select the desired tables for the query from the Show Table dialog box.  Either double-click on a table’s name from the list, or single-click on it, and click the Add button to add the table to the Table pane of the query window.  Click the dialog’s Close button to close the dialog box and continue building the query.

To add fields to the query, drag them from the table listing (in the Table pane) into the design grid (lower half of the window).  You can also double-click on a field to add it to the design grid.

Click the Save button on the Database toolbar and provide a name for the query in the Save As dialog box.  Click the OK button on the dialog box to complete the save operation.

You can now click the Datasheet button on the Database toolbar to switch to Datasheet view and see the results of the query you have created.

Notes:
This section concentrates solely on building a new query of fields from a single table.  No query criteria are added to the query at this time.
Section 6.1.2 – Modifying a Query Object

Concept:
Modifying an existing query object

Method:
To modify or edit an existing query object, click the Queries button in the Database window, then either select the query object to edit and click the Design button on the Database toolbar, or right-click on the desired query object and choose the Design View item from the shortcut menu.

Notes:
The material in this section concentrates on editing an existing query and reordering the fields of the query by dragging them to a different position in the design grid.

Section 6.1.3 – Specifying Search Criteria

Concept:
Adding search criteria to a query

Method:
To add criteria to a query, open the query in Design View (see above) and enter a search criteria expression in the Criteria text area under the desired field in the query.  Only those records whose corresponding field matches the expression provided will be shown in the query.

Several of the expressions demonstrated in the section include:

· =“text value” – where text value is a text string that matches the value of the field

· >num – an expression comparing against a numeric value (num)
· Like r* - an expression that matches text values starting with the letter “r”.

· Between 18 and 20 – an expression that matches a range of numeric values

You can also include a field in the query criteria without showing it as part of the output results of the query.  To do so, simply uncheck the Show checkbox.

Notes:
Additional query criteria operators are listed in Table 6.1 of the textbook.

Section 6.2 – Creating Multi-Table Queries

Section 6.2 covers the fundamentals of multi-table queries.  The section focuses on adding and removing tables and adding and removing fields in existing queries, specifying multi-table criteria, and previewing and printing the results of queries.

Section 6.2.1 – Adding and Removing Tables

Concept:
Adding a table to an existing query

Method:
To add a table to an existing query, open the desired query in Design View.  Click the Show Table button on the Database toolbar, and select the table(s) to add to the query from the Show Table dialog box.  Click the Add button to add the selected table(s) to the query, and click the Close button to complete the process.

Notes:
None.

Concept:
Removing a table from a query

Method:
To remove a table from an existing query, open the desired query in Design View.  Select the table (and its field listing) from the Table pane.  Once selected, press the Delete key or right-click on the desired table, and choose the Remove Table menu item from the shortcut menu.

Notes:
None.

Section 6.2.2 – Adding and Removing Fields

Concept:
Adding all of a table’s fields to a query

Method:
To add all of the fields of a table to a query, double-click on the table’s “*” field in the query Design View.  This action will add a field named tablename.* to the query, indicating that all of the fields of the table named tablename shall be added to the query.

Notes:
None.

Concept:
Adding a specific table field to a query

Method:
To add a specific table field to an existing query, open the query in Design View and drag the desired field from the Table pane to the design grid.  Alternatively, you can double-click on the field to add it to the design grid, or select the field’s name from the Field drop-down list in the design grid.

Notes:
None.

Concept:
Removing all of the fields from a query

Method:
To remove all of the fields from a query, open the query in Design View, and choose the Clear Grid menu item from the Edit menu.

Notes:
None.

Concept:
Removing a field from a query

Method:
To remove a specific field from a query, select the field’s column in the design grid and press the Delete key, or choose the Delete Columns menu item from the Edit menu.

Notes:
None.

Section 6.2.3 – Specifying Multi-Table Criteria

Concept:
Specifying query criteria for multiple tables

Method:
To specify a valid set of criteria from multiple tables, provide query criteria for the desired fields by completing the Criteria text area for each field.

Notes:
When performing a multi-table query, ensure that valid relationships exist between the desired tables. If relationship joins are not defined correctly, Access may display a meaningless combination of records retrieved from the two tables.
Section 6.2.4 – Previewing and Printing the Dynaset

Concept:
Previewing the resulting dynaset

Method:
To preview the results of a query, view the query results in Datasheet view and then click the Print Preview button on the Database toolbar.

Notes:
None.

Concept:
Printing a query’s results

Method:
To print the results of a query, view the query’s results in Datasheet View and then click the Print button on the Database toolbar.  Complete the standard Print dialog box to send the results to the desired printer.

Notes:
None.

Section 6.3 – Enhancing a Select Query

Section 6.3 provides instruction on more advanced forms of the select query.  This section covers how to sort query results, how to apply a filter to a dynaset, specifying multiple criteria in different fields or in a single field, and how to use the logical operators AND and OR.

Section 6.3.1 – Sorting Query Results

Concept:
Sorting the results of a query

Method:
To specify the sort order of the results of a query, you must edit the desired query in Design View.  Click in the Sort text box of the desired field you wish to sort, and click the down arrow attached to the text box.  Select either the Ascending, Descending or (not sorted) item from the drop-down list.

The query results will then be sorted according to the selected sort criteria for this field.

Notes:
If more than one sort criteria are specified in a query, the criteria are applied from left-to-right as they are listed in the design grid.

Section 6.3.2 – Applying Filters to the Dynaset

Concept:
Applying filters to a query dynaset

Method:
To apply a filter to a query’s dynaset, display the query’s results in Datasheet View.  Apply a filter using one of the methods below:

· Select a value from a record in the datasheet and click on the Filter by Selection button on the Database toolbar.  Only those records which have the same value as the selected value (in the same field) will be displayed.

· Click on the Filter by Form button on the Database toolbar.  In the Filter by Form dialog box use the field drop-down lists to select the values to apply to the filter.  More than one field can affect the filter at any time, so there is no reason to select from only one field (unless desired).  To filter the records, click the Apply Filter button from the Database toolbar.

Notes:
If desired, you can save a filter specification as a new query object.
Concept:
Removing a filter from the dynaset

Method:
To remove a filter that has been applied to a dynaset, click the Add/Remove Filter button on the Database toolbar.

Notes:
None.

Section 6.3.3 – Specifying Multiple Criteria in Different Fields

Concept:
Joining criteria using AND and OR

Method:
Enter criteria on the same Criteria row of the query Design grid to join statements using a logical AND. Only records meeting both criteria statements are returned for display in the dynaset
Enter criteria on the Or rows of the query Design grid in order to join statements using a logical OR. Multiple criteria entered on different rows for the same field create the option of matching one or more of the specified criteria for that field.

Notes:
None.

Section 6.3.4 – Specifying Multiple Criteria in a Single Field

Concept:
Using the AND or OR operators within a single criteria field

Method:
When entering field criteria, you can specify multiple criteria for a single field (within a single criteria cell) by making use of the AND or OR logical operators to separate the criteria.

For example, you can use >20 AND <65 for one field’s criteria.  Likewise, you can enter “Personal” OR “Business” as one criteria entry, rather than breaking them into two entries and placing them on different rows within the field’s criteria. 

Notes:
None.

Section 6.4 – Performing Calculations

Section 6.4 concentrates on advanced field techniques in queries.  The section provides instruction on creating a calculated field, setting field properties, using the Expression Builder to create calculated fields and criteria, and creating summary queries.

Section 6.4.1 – Creating a Calculated Field

Concept:
Creating a calculated field in a query

Method:
Create a calculated field (based upon an expression) in a query by providing a new field name and the expression in the Field text box in Design View.

To display a calculated field in a query’s dynaset select an empty field column in the query Design grid, click in the Field text box in the empty column and type field name: expression.  For example: New Grade:[Roster]![Grade]*1.06
creates a new field named New Grade which displays the results of the specified formula.

If the query uses more than one table, specify the table name separated from the field using an exclamation point: [TableName]![FieldName]
Notes:
Although Access 2003 will add the square brackets for you automatically, it is best to learn that both table and field names require brackets when used in expressions.
Section 6.4.2 – Setting Field Properties

Concept:
Setting field properties for query fields

Method:
To set the properties for a field, display the query in Design View, and right-click on the field column in the Design grid and choose the Properties menu item from the shortcut menu.  In the Field Properties dialog box provide values for such properties as the Description, Format, Input Mask, and Caption.

Notes:
None.

Section 6.4.3 – Using the Expression Builder

Concept:
Using the expression builder to define calculated fields or specify criteria
Method:
The Access Expression Builder is a tool which can be used to build an expression to define a calculated field or specify criteria.  To use the builder, select either the field or criteria text box, when the desired query is shown in Design View. Click the Build button in the Database toolbar to display the Expression Builder interface.

The Expression Builder provides a complex interface to browse the various tables, reports, queries, and forms of the current database; providing access to each of their objects.  In addition, the builder also provides access to the various functions and operators you can use in an expression.  Expressions built using the Expression Builder are added to the selected field or criteria by clicking the OK button of the builder’s dialog box.

Notes:
None.

Section 6.4.4 – Creating Summary Queries

Concept:
Creating summary queries

Method:
Summary queries can be created to group data together, creating aggregate calculations.  To create a summary query, click the Totals button on the Database toolbar, or choose the Totals menu item from the View menu.

Select a cell in the Totals row of the desired field column, and select a calculation option from the drop-down list box.

Notes:
None.
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	Extra Curricular Activities


Activity 1 Create a new query in the MyCopy database from the Extra Curricular Activities from Chapter 5 (a copy of the AC0500 database).  In this query, list all information for each student who has a GPA of better than 3.5 and who is graduating in 2005.  Save the new query as GreatStudentsOf2005 in the database.

Activity 2 Modify the query you created in Activity 1 to include students graduating in the class of 2006.  Save this new query as GreatStudentsOf0506.

Activity 3 Add a new field to the Courses table in the database you have been working with in Activities 1 and 2.  Add the FeeAmount field.  For each course that collects a fee, add a value of $35 as a fee.  For all other courses, leave the field null.  Then create a new query named MaxFeeIncome which tallies up the maximum possible income based on course fees (for each course).  With a $35 fee, and the maximum number of students per course, you should be able to query the table to determine how much income each course may bring in.
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Chapter 6 
Answers to End-of-Chapter Questions

Short Answer

1. A select query retrieves data for display and performs temporary calculations. An action query performs mass changes to your data. While the results of a select query are displayed in a datasheet, an action query can permanently update fields in a table, delete records, append records, and even create a new table.

2. When you provide examples of the data you are looking for in a database, you are using the query-by-example features of Access. To display only those customers living in Boston, for example, you enter “Boston” in the Criteria text box of the field containing city values. You are, in essence, asking Access to take your example entry and apply it in a search condition on the database. The Filter By Form window and the query Design window both illustrate query-by-example features.

3.
The query Design window enables you to create and modify query objects in Access. The window itself is divided into two panes by an adjustable Split bar. The Table pane, appearing at the top, contains the field list objects for tables used in the query. If tables are related, a relationship line appears between the common fields. The query Design grid is used to specify the fields for display in the query and for entering criteria specifications and selecting sort orders. You can also use the query Design grid to create calculated fields and to enter expressions. 

4.


a. DOUBLE-CLICK: the desired field in the field list object 

b. DRAG: the desired field from the field list object and drop it into the Field row of the query Design grid

c. SELECT: a Field text box in the grid 
CLICK: down arrow attached to the text box
SELECT: a field name from the list

5.
There are many possible answers to this question. Two examples include “Johnson” and “Johnston.”

6.


a. Both tables must contain a field of the same name and data type.

b. One of the common fields must be a primary key.

7.
Of the fields selected for sorting, the leftmost field column becomes the primary sort key, while the remaining columns are sorted according to their column order, from left to right.

8.
The AND logical operator evaluates to true when both of the criteria statements, appearing on either side of the operator, are true. The OR logical operator evaluates to true when either of the criteria statements, appearing on either side of the operator, are true. You typically employ the AND and OR operators when you need to enter a conditional statement into a single cell in the query Design grid.

9.
A calculated field is a temporary value that is calculated on the fly using the contents of other fields. Storing the result of a calculation in a table is a waste of disk space, since the calculation can be performed at any time. Because a calculated field is dependent on other values, the stored result would require updating when its dependent values changed. As a result, if a value can be calculated, the general rule is that you should not store it permanently in the database. 

10.
In the Total drop-down list box, the following options are provided: Sum, Avg, Min, Max, Count, StDev, Var, First, and Last. The other options appearing in this list box that are not calculations include Group By, Expression, and Where.
True/False

	1.
	T
	6.
	F

	2.
	T
	7.
	F

	3.
	F
	8.
	T

	4.
	T
	9.
	T

	5.
	F
	10.
	T


Multiple-Choice

	1.
	d
	6.
	a

	2.
	c
	7.
	b

	3.
	d
	8.
	b

	4.
	d
	9.
	c

	5.
	a
	10.
	d
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